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Introduction
1 Introduction

The Microsemi Netlist Viewer is a graphical representation of the design netlist. As FPGA designs grow
in size and complexity, it has become essential for the FPGA designer to traverse the netlist to analyze
the design.

1.1 Supported Families and Platforms
The Netlist Viewer supports SmartFusion2, IGLOO2, RTG4, and PolarFire devices and runs on Windows
and Linux systems.

Note: Depending on the device selected, some UI elements such as icons, options, tabs, and dialog boxes 
may vary slightly in appearance and/or content. Basic Netlist Viewer functionality remains the same, 
regardless of the device chosen. In this user guide, a PolarFire device has been used in the example 
figures.

1.2 Views
The Netlist Viewer is a graphical user interface that displays different views for the different stages of the
design process:

• RTL netlist view - Technology-independent netlist view of the design before mapping of the 
design elements to the Microsemi-specific technology. Using the RTL view is a fast and easy 
way to determine whether the correct logic has been implemented by the software. Cross-
probing from this view to the HDL code facilities troubleshooting when the design is not working 
as desired.

• Hierarchical Post-Synthesis view - Hierarchical view of the netlist after synthesis and after 
technology mapping to the Microsemi FPGA technology.

• Flat Post-Compile Netlist view - A flattened netlist after synthesis, technology mapping and 
further optimization based on the DRC rules of the device family and/or die. 

• Flat Post-Compile Cone view - This view loads the same netlist as the Flat Post-Compile view, 
but does not initially draw anything on the canvas. Important parts of the design can be added to 
the canvas from the tree or from the existing items in the view. This view opens much more 
quickly than the Flat Post-Compile view. It allows you to load only the parts of the design you 
are interested in. This view is well-suited for use with large designs. This view is not available 
for all families.
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Introduction
Figure 1 •   Netlist Viewer - RTL View
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Introduction
Figure 2 •   Netlist Viewer - Hierarchical Post Synthesis View

Figure 3 •   Netlist Viewer - Flat Post-Compile View

Note: A progress bar indicates that the flattened netlist is being loaded. For a large netlist, the loading may 
incur some runtime penalty. A Cancel button is available to cancel the loading.
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Figure 4 •   Netlist Viewer - Flat Post-Compile Cone View 
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2 Invocation

The standalone Netlist Viewer is available for invocation in the Design Flow window.

To open the standalone Netlist Viewer in the Flow Window, do one of the following:

• Double-click Netlist Viewer inside the Design Flow window.
• Right-click Netlist Viewer and select Open Interactively (Netlist Viewer > Open Interactively)

Figure 5 •   Netlist Viewer Invocation — Design Flow Window

When Netlist Viewer opens, it makes available for loading and viewing the following views of the netlist:
• RTL - Available after design capture/design generation 
• Hierarchical Post-Synthesis - Available after Synthesis
• Flat Post-Compile - Available after Synthesis or Place and Route. If after Place and Route, the 

Netlist Viewer loads the Flat Post-Compile view to reflect the netlist generated after Place and 
Route.

• Flat Post-Compile Cone - Available after Synthesis or Place and Route. If after Place and Route, the 
Netlist Viewer loads the Flat Post-Compile view to reflect the netlist generated after Place and 
Route. This view does not display any netlist on the canvas until an instance from the design tree is 
selected and loaded. This view allows you to load in a special area of the design you are interested 
in. It also cuts down the runtime.



Netlist Viewer Windows
3 Netlist Viewer Windows

When the standalone Netlist Viewer opens, no netlist views are loaded. The Start Page shows the netlist
views that can be opened for viewing.

The Netlist Viewer User Guide is available from the Design Flow window (Netlist Viewer > Help >
Netlist Viewer User Guide) and also from the Help menu (Help > Reference Manuals). 

3.1 Opening a View
Click any of the following views (across the top-left corner) to load the netlist into the Netlist Viewer for
viewing:

• RTL view - Pre-synthesis RTL netlist is drawn in the view.
• Hierarchical Post-Synthesis view - Post-Synthesis Netlist is drawn in the view

Note:Not available if synthesis is disabled in the design flow (Project > Project Settings > Design 
Flow > Enable Synthesis is unchecked) 

• Flat Post-Compile view - Flattened Post-Compile Netlist is drawn in the view.
• Flat Post-Compile Cone view - No netlist is drawn until design objects are added to the view.

Figure 6 •   Nelist Viewer on Start Up

Note: When netlist views are opened for the first time in the Netlist Viewer, they are loaded into system 
memory and remain in system memory until the Netlist Viewer exits. For very large designs, loading the 
netlist for the first time may incur some runtime penalty. A pop-up window reports the status of the 
loading process.

Note: The Flat Post-Compile Cone view takes very little runtime because no netlist is drawn when this view is 
first loaded. This view does not display a netlist until instances from the design tree are selected and 
loaded. 
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Netlist Viewer Windows
Figure 7 •   Loading New View Popup Window 

When the netlist views are opened for the second and subsequent times, the netlist views are available
almost immediately in the Netlist Viewer because they are already loaded into the system’s memory.

3.1.1 Displaying the Flat Post-Compile Cone View
When the Flat Post-Compile Cone view has finished loading, unlike the other three views, nothing is
drawn in the canvas.

Figure 8 •   Flat Post-Compile Cone View when Loaded — No Design Object Added

Opening a design in the Flat Post-Compile view may incur some runtime penalty. This (cone) view loads
the same AFL netlist source file as the Flat Post-Compile view. However, this (cone) view, unlike the Flat
Post-Compile view, draws nothing until you select the part of the design you want to display. This
reduces the runtime penalty very often associated with drawing a large netlist for display.

This view is useful when a small or critical part of a very large design needs to be examined.

Design objects that can be selected for display in this view include:

• Nets
• Ports
• Macros
• Components
Revision 3.0 12
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To display design objects in the Flat Post-Compiled Cone view, right-click the design object
(net/macro/port/component) in the Design Tree and select Load Selection. The design object is added
to the view.

Figure 9 •   Flat Post-Compile Cone View — Design Objects Added 

3.1.1.1 Adding a Net
Right-click a net in the Design Tree and select Load Selection to add a net to the view. Adding a net to
the view adds a solid line net to the view (unless you cancel early), including all the instances and ports
the net is connected to. The added net is selected in the view.

Nets that span multiple pages can be followed through the right-click menu item Follow Net to Page# to
go to different pages that the net is on.

Figure 10 •   Net Added to View — Solid Line

3.1.1.2 Adding Macro
A macro is a basic low-level design object from the Macro Library in the Catalog. Right-click a macro in
the Design Tree and select Load Selection to add a macro. Adding a macro adds the instance with its
connected nets to the view. The connected nets are always dashed yellow lines, even if they are not
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connected to any logic outside the view. Double-clicking the net adds connections (if any) and turns the
net from a dashed line to a solid line. A solid line for a net indicates that it is a user-added net.

Figure 11 •   CFG4 Macro Added

3.1.1.3 Adding a Port
Right-click a port in the Design Tree and select Load Selection to add a port to the view. Adding a port to
the view is the same as adding the net connected to the port. 

3.1.1.4 Adding a Component
Right-click a component in the Design Tree and select Load Selection to add a component to the view.
Adding a component to the view is the same as selecting all lower level macros and adding them to the
view. The added macros are selected. 

Note: For very large components with many low level macros, to save runtime the macros are added but 
cannot be selected. 

Figure 12 •   Component Added

3.1.1.5 Load/Driver Display
Design objects can also be added to the view through the right-click menu to add load/driver. This action
adds any instances at the different logical levels.
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3.2 Closing a View
Click an opened view (across the top of the Netlist Viewer) to close that opened view. A closed view
stays in system memory as long as the Netlist Viewer remains open. Opening the same netlist view at a
later time does not incur runtime penalty, as no loading is required.

3.3 Netlist Viewer Windows
When the Netlist Viewer opens, it displays three windows by default: 

• Design Tree window - displays the design hierarchy from the top level
• Canvas Window - displays the netlist views
• Log Window - displays messages/warnings/Info etc.

Figure 13 •   Netlist Viewer Windows

3.4 Design Tree Window
This window displays the design hierarchy from the top level. By default, when the Netlist Viewer opens,
it displays the Design Tree window.

Note: The Design Tree window is displayed by default when the Netlist Viewer opens. Hiding the Design Tree 
view will leave more display area for the Canvas view. To get a bigger display area for the canvas view, 
hide the Design Tree window (Netlist Viewer > Windows > Uncheck Show Tree)

The Design Tree window displays:

• Nets (<integer>) - the number in brackets is the total number of nets at the top level. 
• Ports (<integer>) - the number in brackets is the total number of ports at top level
• Design components under the top level - each component can be collapsed or expanded to expose

• nets - total number of nets at the component level
• ports - total number of ports at the component level
• subcomponents inside the component

• Fanout Values (Nets) - When two numbers are displayed in the bracket, the first number is the 
fanout of the net at the local level (of hierarchy) and the second number is the fanout of the net at the 
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global level. As an example, net_xyz (fanout:1,3) means the net goes down the levels of hierarchy to 
three different pins (global fanout 3) and is not connected to any other pins at the current level (local 
fanout 1).

• Primitives - Primitives refer to macros and low-level design objects and can appear in the top level or 
component level.

The design tree is different with different netlist views. For the Flat Post-Compile view, the design tree
displays a much larger number of nets than the RTL view or Hierarchical Post-Synthesis view, because
the netlist is flattened in the Post-Compile view and all nets are counted. The nets in the Flat Post-
Compile view, unlike the RTL view or the Hierarchical Post-Synthesis view, shows only one value for
fanout (global fanout) because it is a flattened view (no hierarchy).

For nets that are part of a NetBundle, the NetBundle name is followed by a number in parentheses that
indicates the total number of nets in the NetBundle.

Figure 14 •   Design Tree Window

3.4.1 Filter
The display of design objects in this view can be filtered based on:

• Ports - displays all ports only, including component level ports
• Nets - displays all nets only, including component level nets
• Instances - display all instances only, including component level instances
• Modules - display all modules only
• Filter All - display all design objects only
• Use Wildcard Filter
• Use Match Filter
• Use Regular Expressions
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Click the Filter button at the top-right corner of the Design View to filter design objects.

3.4.2 Interoperability Between Windows and Views
When a design object such as a net, an instance, or a port is selected in the Design Tree window, the
object is selected in the different netlist views. The reverse is also true. An object selected in one netlist
view window is also selected in the Design Tree window and other netlist views. 

Interoperability works only when the Toggle Crossprobing icon is enabled.

3.5 Canvas Window
The Canvas Window displays the:

• RTL view
• Hierarchical Post-Synthesis view
• Flat Post-Compile view
• Flat Post-Compile Cone view
• Cones view
• Opened HDL files (not available in the Flat Post-Compile view)
• Start Page - when no netlist views are opened
When a view is opened, a view tab is added across the top of the Canvas window for ease of switching
between views. 

Note: To get a larger display area for the Canvas view, hide the Design Tree Wwndow (Netlist Viewer > 
Windows > Uncheck Show Tree) and hide the Log window (Netlist Viewer > Windows > Uncheck 
Show Log). Hiding the Log window and the Design Tree window leaves more display area for the 
Canvas window. Alternatively, press CNTL+w to maximize the work area.
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Figure 15 •   Turn On/Off Design Tree Window and Log Window

Icons in the Canvas window allow the user to:

• Traverse vertically up (Pop) or down (Push) the design hierarchy
• Navigate horizontally across different pages of the design view
• Zoom in/out of the design view
• Trace critical nets to the driver/load
• Create logical cones for debugging
• Control the color display the design objects

Figure 16 •   Canvas Window

3.6 Log Window 
The Log window displays the following:

• Informational messages such as the location and name of the files used to display the view
• Syntax errors, if any, in the HDL file if the HDL file is opened with the “Open File Location” option 

(Right-click design object > Open File Location).
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Note: The Log window displays by default when the Netlist Viewer opens. Hiding the Log window will leave 
more display area for the Canvas view. To get a larger display area for the Canvas view, hide the Log 
window (Netlist Viewer > Windows > Uncheck Show Log)

Figure 17 •   Log Window

3.7 Status Bar
The status bar at the bottom right corner of the Netlist Viewer displays the following:

• Mode - Either Global or Local mode is displayed. Global mode means the Netlist Viewer can cross 
hierarchical boundaries when following nets to drivers or loads. Local means the Netlist Viewer stays 
in the current level of design hierarchy.

• Current Level - displays the current level of design hierarchy, either TOP_LEVEL instance name or 
instance name of the component.

• Current Page - displays the current page of the Netlist Viewer (Page x of <total>) when traversing 
across different pages of the Netlist Viewer.

• Fam - displays the technology family.

Figure 18 •   Status Bar
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